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Getting Started with a ’blank’ desk
To erase all memories in the desk, and return it to its factory settings, hold the SCENE MEMORY [STORE] switch
while turning on the power, and choose the INITIALIZE option. (You don’t need to do this if you have just unpacked the
product from its box for the first time)!

To start from blank settings without erasing the memories, just recall SCENE 00. To do this, use the SCENE MEMORY
Up-Arrow/Down-Arrow switches to select Scene ‘00’ and then press [RECALL].

All the faders will then move down and all the mixing functions set to their default status.

Understanding the Rear Panel and Top Connectors
All the analog input connectors are at the back of the top panel. The analog outputs and digital I/O are found on the rear
panel. They include:

Rear Panel
Monitor Out with Jacks, for connecting to
powered monitor speakers (or an amp for
powering passive speakers)

ADAT optical 8-channel Digital Input and Output
(for multi-track recorder or computer sound card, for example).
2-Track Digital Out and In
(for Mini-Disc/DAT, for example)

4 ‘OMNI’ analog outputs
with Jacks

Main Stereo Output with XLRs

USB 2.0 port for multi-track live
recording with DAW software and
Yamaha Studio Manager software.

1 option slot for expansion

Other connectors on the rear panel are for various control and sync functions. For example, the WORD CLOCK connectors are for synchronizing with other digital audio devices, the MIDI ports are for communicating with other musical instruments (such as keyboards).
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Top Panel
INPUT A/B connectors accept mic/line inputs with XLR and balanced TRS
phone jack respectively. If you plug cables to INPUT A and INPUT B of the
same number, only the signal from INPUT B is effective.

Unbalanced insert jacks for the 12
mic/line inputs
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4 Line inputs with
balanced jacks
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Understanding the Front Panel
All the controls are on the front panel, laid out in logical areas:
Display Access switches
(choose what to view on the LCD)

Analog input gain and pad (+48V switches are on the rear panel,
and switch on phantom power for 4 channels at a time)

Monitor and
Headphone controls

Display control and Scene
Memory buttons

EQ and Pan controls for the
selected channels ✽

Level pots, On, Solo, Sel for
the Stereo input channels

Aux select and Fader Layer buttons

Faders, On, Solo, Sel buttons
for the channels

User Defined Keys (for
short-cuts)

✽ The SELECTED CHANNEL area is a fundamental concept to understand. It shows important functions for one

channel at a time. Only one channel can be selected at any time. To select a channel (and see its settings in the
SELECTED CHANNEL area), just press the [SEL] button. Then press the[ SEL] button for another channel when
you are ready to move on.
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Controlling Channel Faders
There are 4 layers of faders on the 01V96i:
When you change layers, all the channel settings are remembered. You just change which channels you are looking at!

Master Layer: Aux 1-8, Bus 1-8

Input channels 17-32

Remote Layer for controlling other
functions / devices

Input channels 1-16

Each fader controls a different input to the 01V96i. This assignment is not fixed: it can be changed in the PATCH
menu.
Here is the default patch:
☞ channels 1-16 control the 16 analog inputs on the top on the console;
☞ channels 17-24 control ADAT inputs 1-8;
☞ channels 25-32 control inputs 1-8 from the Slot;
☞ stereo channels 1-4 control inputs from internal Effects 1-4.
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Changing INPUT PATCH
To assign different inputs to the input channels, such as Slot 1 inputs 9-16, follow these steps:

1.
2.

3.

4.

5.

6.

Press the [PATCH] DISPLAY
ACCESS key.

1

If necessary, press it repeatedly
until the IN PATCH page is displayed.

Press the [SEL] button for the
required channel (or move the cursor on the screen to the required
channel number).

3

Press [ENTER] (by the data wheel
on the right side of the console).
This will open the PATCH SELECT
window.

Select the type of input from the
first list (AD in / Slot in / FX out
and so on).

2

Press [ENTER] and choose the
required item from the next column (CH# or FX unit for example).

PATCH SELECT window

4
7.

Press [ENTER] and click YES on
the screen to complete the Patch
change.

5

6
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FADER MODE
There are nine FADER MODE keys to the left of the LCD.

[HOME] is the normal mode for the faders. Pressing the [HOME] key will show various METER pages on the LCD, so
input, output, and Effect channels can be metered.
The AUX 1-8 keys select one of the Aux Send levels to be edited by the faders, instead of the normal channel level. You can
also see the Aux Send levels on the LCD, represented either by rotary pots or by bar-graphs. Pre and Post Fade settings can
only be edited on the LCD, by using the cursor keys and the [ENTER] key. By pressing the [ENTER] key while the cursor
is over an Aux Send rotary pot, the Aux Send will be switched Off/On.
Pressing [HOME] again will always return the faders to show the channel fader level.
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Using the SELECTED CHANNEL controls
When a channel is selected, some of its settings can be seen and controlled in the SELECTED CHANNEL area. The currently selected channel’s name and number is always shown in the top-left corner of the LCD screen.
✦ SELECTED CHANNEL area

✦ EQUALIZER
When one of the EQ controls is moved, the LCD will show the EQ edit screen. There are 4 parametric bands. Select
which band to control with the HIGH, HIGH-MID, LOW-MID and LOW switches. Note that the LOW band can be a
Low Shelf or a HPF by changing the Q to the maximum or minimum position. In the same way, the HIGH band can
be a High Shelf or a LPF. There are 2 types of EQ (TYPE I or TYPE II), with slightly different sound characteristics.
The ATT function (seen in the LCD next to the EQ curve) is an attenuator, or digital trim, to adjust the channel level
pre-eq.
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✦ PAN
The PAN settings of the selected input channel can be edited here (output channels do not have Pan). 01V96i can also
perform surround panning. To select a SURROUND MODE, press the [PAN/ROUTING] Display Access Key so the
SURR MODE page is shown on the LCD. Then choose the SURROUND MODE: 3-1 or 5.1 or 6.1. This will then convert some of the buses (1-8) into Surround Buses, and more displays will be added to the PAN menu for editing the
Surround Panning parameters.

In SURROUND MODE

10/32

01V96i Quick Start Guide

✦ DYNAMICS
Each input channel has both a GATE and a COMP. The output channels only have a COMP. When the [DYNAMICS]
Display Access key is pressed, the LCD shows the relevant GATE or COMP screen. Gain Reduction meters and Key-In
source can also be viewed here. Usefully, the COMP can be positioned pre-eq, pre-fader (post-eq) or post-fader.

or
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✦ ROUTING
In the [PAN/ROUTING] menu, the Selected Channel can be routed to any of the 8 Buses, to the Stereo Bus and to a
Direct Output. Move the cursor to the required bus number ([1-8], [S] for Stereo and [D] for Direct output) and press
[ENTER] to route the channel. The PAN indicators below each channel number in the LCD ensure that the PAN of
the channels will follow through to the Buses. This is particularly useful when using the Buses as stereo sub-groups
(like on a typical analog console).

Cursor

ENTER

Buses can be routed to Stereo (just like Sub-Groups on an analog console). To do this, press the [PAN/ROUTING]
button to view the BUS TO ST screen. Here Buses 1-8 can be routed, panned and mixed to the Stereo Bus. Use the cursor keys, data wheel and [ENTER] switch to adjust the parameters.

Cursor

Data wheel
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✦ Ø / INSERT / DELAY
Press this DISPLAY ACCESS key to see Phase, Insert and delay information on the LCD. Phase reverse is only available for input channels. Insert and Delay are available for all channels except for the Stereo Inputs. Inserts need to be
patched, choosing which rear-panel connection (or internal Effect) to use for INSERT OUT and INSERT IN. The
INSERT POSITION can also be changed here.

Press the [Ø/INSERT/DELAY] key again to see Delay settings for each channel. The maximum possible delay time
varies with sample rate. At 44.1KHz, the maximum possible delay time is 984.1ms. Input channels have an FB.GAIN
(Feedback Gain) and MIX parameter to create a simple delay effect. The DELAY SCALE can be changed to see the
delay time in equivalent distance, number of samples, beats-per-minute or number of Frames (linked to MIDI
Machine Control Frame Rate).

After editing the delay time for one channel, double-click the [ENTER] key to copy this time to all the other channels.
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CHANNEL PAIR
If some Stereo input sources are used, such as a Synthesizer or CD player, it could be useful to pair the relevant input
channels together. There are two modes for pairing channels, as selected in the [PAIR/GROUP] menu.
HORIZONTAL
VERTICAL

Horizontal mode allows odd numbered channels to be paired with their adjacent even numbered channel.
Vertical mode allows channels on the top fader layer (1-16) to be paired with the equivalent channel on the layer below
(17-32).
Output Buses and Auxes can also be paired, but only Horizontally.
When channels are paired, they share the same fader level, the same ON, EQ, Gate, Comp, Aux settings. Pan and Routing
parameters remain separate (though Pans can be linked separately).
To quickly pair channels without using the LCD screen, first 1 hold down the
[SEL] button for the Left channel, then 2 also hold down the [SEL] button for
the Right channel (or vice versa) for half a second. This only works in Horizontal Pair Mode.
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FADER GROUPS
Fader Groups are useful for controlling many faders by just moving one fader. There are 8 Fader Groups available for
input channels and 4 Fader Groups for output channels.
Here is how to link faders together in a Group:

1.
2.

3.

Access the [PAIR/GROUP]
displays on the LCD.

1

2

Choose a Group (A to H for
inputs, Q to T for outputs)
using the Cursor keys (right of
the console, by the data wheel).

3
Press the [SEL] buttons for the
required channels to include
them in the Group.

Now, when one fader in the Group is moved, all the others move by the same amount. If one fader in the Group needs to
be moved by itself, then hold that channel’s [SEL] button while pushing the fader (but not while the GROUP menu is displayed, or else the channel will be removed from the Group).
NOTE: Channels cannot be in more than one Fader Group at the same time.
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MUTE GROUPS
Mute Groups are useful for switching On/Off many channels by just pressing one switch. There are 8 Mute Groups available for input channels and 4 Mute Groups for output channels. To assign channels to a Mute Group, follow the same 3
steps as made for a Fader Group, but while viewing the MUTE GROUP screens (Groups I to P are for Inputs, Groups U to
X are for Outputs).
Once a Mute Group is made, when the [ON] button for one channel is pressed, all the other channels in the same Group
are also switched On/Off.

CHANNEL VIEW
The [VIEW] Display Access Menu provides some useful displays, showing all the important parameters for the selected
channel. The PARAMETER page shows EQ, Comp, Gate, Insert, Delay, Pair information, while the FADER page shows
Pan, Aux, Bus Routing, Group status. There is also a LIBRARY page where channel data can be stored and recalled.
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EFFECTS
There are 4 Multi-Effect Units inside 01V96i. They can be viewed on the LCD by pressing the [EFFECT] Display Access
key, and then pressing one of the buttons [F1]-[F4] below the LCD.

✦ EDITING AN EFFECT
The Effect parameters can be edited using the data wheel and cursor keys to the right of the console.
To change the type of effect (from Reverb to Rev-X for example), follow the LIBRARY link shown on the left side of
the LCD to see the FX LIBRARY. Then scroll through the list with the data wheel, and press [ENTER] with the cursor
over the RECALL button on the left of the screen.
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✦ USING AN EFFECT
Before an effect can be used properly, it needs to be
patched. The default patch (factory setting) has Aux 1-4
patched to the inputs of FX1-4 respectively. The stereo outputs of FX1-4 are patched to stereo input channels 1-4
respectively. This is convenient, but can be changed if necessary. For example, an effect could be inserted in just one
channel using the INSERT OUT and IN patch. To change
the FX patching, go to the EFFECT page in the [PATCH]
display menu.

✦ ROUTING AUDIO THROUGH AN EFFECT

1.
2.
3.
4.

First, audio needs to be routed into the effect. If the default patch is used, first turn up Aux 1 send level for the
required channel: Select Aux1 fader mode, and push up the fader to the required level.

Check that the Aux 1 Master fader is up to 0dB (that is its default position): select Master Layer and adjust the
Aux1 fader position if necessary.

Already audio should be seen on the level meters of Effect 1. You can see the meters on the top-right corner of
the FX EDIT screen.

Then turn up ST IN 1 to start hearing the effect’s output in the Stereo bus: select the top layer for the ST IN
channels, and turn up ST IN1 encoder. The level can be viewed in the top-right corner of the LCD.

1

2

3
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SCENE MEMORY
There are 99 SCENE MEMORIES available in 01V96i. Each Scene stores all the mixing
parameters, including all input channel, output channel and Effects parameter data.
The SCENE MEMORY list can be seen by pressing the [SCENE] Display Access key.

If a SCENE is PROTECTED,
it cannot be overwritten
when [STORE] is pressed.
This avoids erasing something by mistake.

When a SCENE is stored, a
name can be entered.

✦ RECALL SAFE
In this screen, choose which parameters will not be changed
when recalling a Scene. When the Global Recall Safe box is
checked (at the top of the screen), the chosen parameters will
be safe in all Scenes. Otherwise, these settings will only apply
to the current Scene (once it is stored).

✦ SCENE FADE
Normally when a Scene is recalled, the Faders move instantly
to their stored position. Using the Fade Time function, the
faders can be programmed to move slowly, taking up to 30
seconds to complete their movement. Checking the Global
Fade Time box will give the same Fade Time to every Scene.
After setting the Fade Time for one channel, double-click the
[ENTER] button to copy the time to all Input or Output
Channels.

19/32

The PATCH LINK feature
can be useful if different
Scenes need different Patch
settings. Patch information is
not stored in the scenes, but is
stored in the INPUT PATCH
and OUTPUT PATCH libraries (accessed from the
[PATCH] Display Access
key). Then the Patch libraries
can be linked to the Scenes so
they are recalled at the same
time as the scene.
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✦ SCENE COPY / PASTE
If some settings need to be copied from one Scene to some others, the PATSE SRC and PASTE DST LCD screens can
be used.
In the PASTE SRC screen, choose which parameters of which
channels should be copied.

In the PASTE DST screen, choose which Scene Memories
should be updated. The maximum number is 10 Scenes for
each operation.

To move a Scene to a different position in the Library, use the
SORT screen in the [SCENE] menu:
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MONITOR
In this section of the console, the operator chooses what to listen to, and controls the listening level.

1.
2.
3.
4.

The MONITOR OUT LEVEL adjusts the main listening level.

The [MONITOR/2TR IN] button selects what to listen to in the monitors, (and in the headphones).

The SOLO [CLEAR] button will turn off SOLO for
all channels.

2

4

1

When monitoring through headphones, adjust the
monitor level using the PHONES LEVEL. The signals output from the MONITOR OUT connectors
are also output from the PHONES jack.

3
Extra MONITOR functions are found in the [DIO/SETUP] menu, on the MONITOR screen. Different SOLO modes can
be chosen, the listening points can be changed (Pre/Post Fader), and the monitor can be switched to MONO:
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Live Recording and Playback with Cubase AI
The 01V96i features USB 2.0 connectivity that allows you to multi-track record 16 in/16 out, with audio streaming at
96kHz/24bit, using Steinberg's Cubase AI bundled DAW software. This chapter will show the simplest method to create
your audio production with the 01V96i and a computer.

✦ Equipment List
● Yamaha 01V96i Digital Mixing Console
● PC or Mac that is compatible with USB 2.0
● Steinberg Cubase AI software
(Bundled with the 01V96i)
● USB cable

✦ Computer Requirements
For the latest information of Cubase AI, check the following web site: http://www.steinberg.net/
Mac OS X

Windows

OS: Mac OS X 10.6 〜 10.8* (32/64bit)
*Supported with Cubase AI V6.0.7 or above

CPU: Intel dual core CPU

OS: Windows 7 (32/64bit)
CPU: Intel / AMD dual core CPU
ASIO, WDM

Core Audio

RAM: 2GB or above
HDD: 4GB of free space or above
Display: 1280 x 800 or above recommended - Full color DVD-ROM Drive
Internet connection for license activation

Tips: For the Hard Disk Drive, It is strongly recommended to use one with a speed of 7200rpm or faster for recording and
playback.
With regard to disk storage, allow 500MB per hour for each mono track at an audio quality of 48 kHz 24-bit. Or 1GB per
hour at 96 kHz 24-bit. So for example, 32GB will be able to record 16 tracks at 96 kHz for 2 hours.
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✦ Recording Methods: To mix or not to mix
There are two methods of recording by routing input channels to DAW software - with or without mixing. You may use
either one or both of the methods according to the number of audio sources.

Direct Out Recording
When recording input signals as they are without mixing, you
can use Direct Out signals.
Prepare tracks on Cubase according to the number of mics and
audio sources, and record the signals without mixing. The level
balance and tone for each input signal are not adjusted during
recording, but can be adjusted later at mixdown - to mix multitrack recordings into stereo.

USB OUT
Connector
INPUT
connector 1

CH 1

Input
Channels 1

INPUT
connector 2

CH 2

Input
Channels 2

INPUT
connector 3

CH 3

Input
Channels 3

INPUT
connector 4

CH 4

Input
Channels 4

INPUT
connector 5

CH 5

Input
Channels 4
Input
Patch

Fig. Each Input channel routes directly to USB OUT

Bus Out Recording
When recording more than 16 audio sources such as multiple
mic inputs and various musical instruments, you can record via
Bus Outs on the 01V96i. A Bus is the signal path that mixes
multiple input signals. The 01V96i is equipped with 8 BUS
(Group buses), 8 AUX buses, and a STEREO (L/R) bus.

USB OUT
Connector
INPUT
connector 1
INPUT
connector 2
INPUT
connector 3
INPUT
connector 4
INPUT
connector 5

CH 1

Input
Channels 1

Bus Out 1

Input
Channels 2

Bus Out 2

Input
Channels 3

Bus Out 3

Input
Channels 4

Bus Out 4

Input
Channels 4

Bus Out 5

CH 2

Input
Patch

Fig. Input channels route to Bus Outs, Bus Outs route to USB OUT.

✦ Wordclock
Wordclock is the signal that synchronizes digital audio equipment from one device to another. The 01V96i supports
recording up to 96kHz/24bit with 16 channels. If you need to change the wordclock source on the 01V96i, press [DIO/
SETUP] button to access Wordclock page and assign (INT48k as default).
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✦ Software setup
The follwoing applications are necessary to be installed in the computer:
● Download and install Yamaha Steinberg USB Driver from Yamaha’s proaudio website.

☞ ( http://www.yamahaproaudio.com/global/en/downloads/firmware_software/ )
● Install bundled Cubase AI and update it to the latest version.

☞ For details on installation, refer to the installation guide on Steinberg’s website.
( http://www.steinberg.net/en/landing_pages/cai6_activation_registration.html )

✦ Recording

1.

2.

Connect the console and computer by inserting the USB cable into the USB 2.0 port on the
rear panel.

Make audio patching for Direct Out or Bus Out:
Direct Out recording:
When recording signals sent from DIRECT OUT,
assign each DIRECT OUT to USB. Select the
channel for recording, and press the [View] Display Access key to access the FADER page. Then
assign USB 1-16 to each DIRECT OUT port
respectively in the BUS ROUTING section and
activate “D (DIRECT OUT)”. Repeat these steps
for all input channels.
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Bus Out recording:
When recording output signals from BUS 1-8 on the
01V96i, route the input channels to the corresponding Bus for recording. (As an example here, using
BUS 1 & 2 for stereo mix recording) Select the channel for recording, and press the [View] Display
Access key to access the FADER page. Then select
BUS 1 & 2 in the BUS ROUTING section. To activate
Pan to the buses, switch ON the FOLLOW PAN
option. Repeat these steps for all input channels.
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Note: For Direct Out recording, you may also choose the position from which the audio signals are sent, e.g PRE EQ (recording is unaffected by EQ, Dynamics and fader adjustments) or
POST FADER (EQ, Dynamics and fader edits affect the recording). To change the setting, press the PATCH key to access the
DIRECT OUT page.

Note: For Bus Out recording, confirm that the Buses required
for recording are patched to USB OUT. Press the PATCH key to
access the USB OUT page and confirm if USB1 set to BUS1,
USB2 set to BUS2 respectively.

3.

4.
5.

6.

Activate the audio signals from the mics or audio sources. Press the HOME(METER) key to open the Meter
page and check the level meter for each input channel (and Bus Outs in case of Bus Out recording). Adjust the
gain to avoid clipping, and set the fader to nominal (0dB) level.
For Bus Out recording, press the MASTER key to show the MASTER Layer and press the SOLO key of BUS 1
& 2 to check the level balance between them.
Startup Cubase AI, open Device Setup in the Devices
menu and set the driver to Yamaha Steinberg USB
ASIO (Yamaha 01V96i) in the VST Audio System section.

Open VST Connections in the Device
menu, and add the necessary number of
recording buses (Mono or Stereo) for
recording.

25/32

01V96i Quick Start Guide

7.

8.
9.

10.

11.

If the Record Format
(44.1kHz – 16 bit by
default) is different to
the 01V96i, it will be
highlighted. Click on it
to change the Record
Format, making sure
the sample rate
matches that of the 01V96i.
Open the Project menu and click Add track to add audio (Mono or Stereo) tracks.
Select the input ports for each
track.
(Tip: To assign all input ports at
one time, you can highlight all
tracks and press Shift+mouse
click).

Turn on the “Enable Rec” icon
on each track for recording. You
may also turn on the monitor
icon on each track to check the
level meter of each track.

Click “Rec” to start recording.
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✦ Playback
After recording, you can playback to check the audio. Follow the instructions below to check the 2-channel stereo mix on
the 01V96i.

1.

2.

3.
4.

To playback through the 01V96i, you need to patch input
channels to USB on the IN PATCH page. If you assign
USB 1-2 to the input channels 17-18, then you do not
need to re-assign the patch again for recording. (Input
channels 17-18 are patched from ADAT by default)

Open VST Connections in the Device
menu, and confirm if the Output bus
(Stereo Out) is added. Also, make sure
the device ports are assigned to
01V96i 1 and 01V96i 2 respectively.
(If the bus is not added, add the output bus (Stereo) in a similar way to
recording.)

Also, make sure the output port on
each track is assigned to Stereo Out.

3

Click “Play” to start playback.

✦ DAW Remote Control
The 01V96i’s Remote function enables you to control external
DAW, such as Cubase. For the information on how to setup the
01v96i to control Cubase, please refer to P.83 of the 01V96i reference manual.
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01V96i Editor
01V96i gives you complete control of all the console’s parameters via your computer. To use 01V96i Editor, you need to
install:
• Studio Manager V2 Host
• 01V96i Editor
• Yamaha Steinberg USB driver

which are available to download on Yamaha proaudio website.

Setup:
To control your 01V96i with the Editor, you need to assign the input and output ports on both Studio Manager V2 Host
and 01V96i Editor.

1.

2.

3.

Press the [DIO/SETUP] Display Access key on the 01V96i
to open the MIDI/HOST page, then patch the Studio Manager port to USB.

When starting up Studio Managar V2 Host for the first
time, choose File>Setup on menu to add 01V96i to
Workspace.

Open the MIDI Settings page to assign the ports on both
Input and Output.
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4.

5.

Open 01V96i Editor, choose File>System Setup on
menu, assign the Input and Output Port.

Synchronization between the console and the Editor.

Convenient save and load data
All of your console’s mix setting can be saved and loaded in your computer and synchronize between
the 01V96i. In case of using a rental or another installed console, you can easily save your settings to
a computer and load them into the other console at your convenience. The data files saved by 01V96i
Editor have a filename extension of “.YSE”.
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01V96i Tips & Short-Cuts
Using the [SEL] switches
1. CHANNEL PAIR
Hold [SEL] for one channel and press [SEL] for the adjacent channel to make a stereo pair. This works for input and
output channels, so long as the left side is an odd number and the right side is an even number. The channel with the
[SEL] button you hold first is the master channel for the pair: its settings are copied to the other channel (except for
pan and bus routing). Repeating this action breaks the stereo pair, to make the channels mono again.

2. CHANNEL COPY
Select the source channel with its [SEL] button, then press
the [CHANNEL COPY] button (this must be assigned to
a USER DEFINED KEY). Then press the [SEL] button of
the destination channel and click [PASTE] (also assignable to a USER DEFINED KEY).
NOTE: The parameters which are copied are determined on the PREFER 2 page in the [DIO/SETUP]
menu.

Other Short-Cuts
1. EQ Gain to 0dB
To reset the gain of an EQ band to 0dB, press and hold the relevant band selection button (in the SELECTED CHANNEL) for one second.

2. EQ Reset
To return the whole Parametric EQ for a channel to its default settings, press the [LOW] and [HIGH] band selection
buttons at the same time.

3. Copy STEREO Mix to an AUX
Press and hold LAYER button [1-16] or [17-32], then press a FADER MODE button [AUX1]-[AUX8], and click YES
in the confirmation box on the LCD. This copies the fader levels to the selected AUX sends. (Make sure the Aux sends
are all PRE by clicking the GLOBAL PRE button on the SEND page in the AUX DISPLAY menu).
NOTE: Repeat the same procedure for each fader layer to copy the whole mix to the Aux sends, as only one layer is copied at a time.
TIP: This is useful for making a quick headphone mix in a recording session, or making a quick stage-monitor mix for a
guest musician at a live performance.

4. SCENE FADE TIME Copy
To assign the same fade time to all channels, first enter the required FADE TIME for one channel, then double-click
[ENTER] to copy the time to all the other input or output channels.

5. DELAY TIME Copy
To assign the same delay time to all channels, first enter the required DELAY TIME for one channel, then double-click
[ENTER] to copy the time to all the other input or output channels.
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Other Tips
1. Fader Groups
To have DCA (or analog VCA) style Fader Masters, first check the INPUT FADER MASTER box near the top of the
IN FADER GROUP display page. Then select the [REMOTE] FADER LAYER, and assign USER ASSIGNABLE
LAYER as the TARGET. After that, all the GROUP MASTER FADERS can be selected to appear on the REMOTE
FADER LAYER, along with any other channels chosen by the user.

2. MUTE MASTER Switches
The USER DEFINED KEYS can be programmed to control the MUTE GROUP MASTER buttons. But first the
INPUT MUTE MASTER and OUTPUT MUTE MASTER boxes must be checked in the MUTE GROUP display
menu. Then the Mute Groups will behave in a similar way to those on a typical analog console: each channel’s [ON]
button is independent, while the Mute Master buttons will mute all the assigned channels, causing their [ON] buttons
to flash.

3. SCENE MEMORY Auto Update
In the PREFER1 page of the [DIO/SETUP] menu, the ‘Scene MEM Auto Update’ option can be found. When this is
switched on, the last mixing settings are memorized just before the next Scene is recalled.
Then when a previous Scene is recalled, its last settings are recalled first. Press RECALL again to access the original
scene settings. So two memories for each scene are kept: the original settings, and the last settings.
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4. Return to Current Scene
When scrolling through the SCENE MEMORY list, it is possible to forget which is the current Scene. To force the display to show the current Scene number again, press both SCENE UP and DOWN buttons simultaneously.

5. USER DEFINED KEYS
Here are some suggested uses for these keys, apart from the defaults:
Scene +1/–1 Recall: to recall the next or the previous Scene.
OSC On/Off: to control the internal Oscillator.
Studio Manager: open and close various windows in the 01V96i Editor software on PC or Mac.
Display Forward/Back: to scroll through previously viewed displays.

6. Initialize Memories
To erase all the memories in the console and return it to is initial settings, first switch off the console. Then switch it on
again while holding the SCENE [STORE] switch. Choose INITIALIZE to erase all the libraries and return to the
default settings.

Check for the latest downloads at
www.yamahaproaudio.com
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